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Features and Enhancements 

This document provides an introduction to new features and enhancements in 

QuarkXPress 2019, including: 

Design Features •

New Table Model with Table Styles •

Box Position Reference Point •

Auto Grow/Shrink Text Boxes •

Spring Loading on Cursor •

  

Graphics •

PDF/UA •

PDF/A Export enhancement •

Export as Image enhancements •

  

Text and Typography •

Paragraph Alignment enhancement •

Paragraph Formatting enhancement •

  

Digital Publishing •

Flex Layouts •

  

User Interface •

New Illustration Tools •

Enhanced Icons and Cursors •

  

Miscellaneous •

Performance Improvements•
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Design Features 

New Table Model with Table Styles 

Formatting tables in QuarkXPress has been time-taking and required repetitive 

efforts for each table you inserted in a document. The table grid formatting options 

were limited to rows and columns with no option for cell level border and shading. 

QuarkXPress 2019 introduces a new table model , offering brand-new table features 

with an intuitive new user interface for formatting tables and creating table styles. 

In Table Styles, you can now capture newly introduced styling rules for table, row, 

column and cell level formatting along with text styling rules. (in previous versions, 

table styles support was limited to Inline tables linked to Excel tables only). With 

the new table model, you can now apply Table Styles to any table created in 

QuarkXPress directly or imported from Excel source. 

QuarkXPress 2019 offers table formatting presets (predefined table styles) for various 

formatting options as a starting point to create custom table styles. 

The new Measurements Palette UI offers much finer control over formatting Tables 

at the cell level. 
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Table Styles palette 

The table styles palette (Window->Table Styles) allows you to apply a table style to 

the currently selected table, to create a new table style, to apply a preset table style, 

or to edit an existing table style. 

Table styles can also be edited, created or deleted using the “Edit Table Styles” dialog 

(Edit->Table Styles). 
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Edit Table Styles 

The user interface for creating or editing a table style is divided into sections 

allowing you to specify table properties, row properties, column properties and cell 

properties. 

Selecting an option in the column on the left-hand side of this dialog will allow you 

to specify the properties that are specific to the selected context. For contexts where 

there are multiple possible options: such as columns and rows - where you can 

select, for example, header row, all odd rows, all even rows, or footer row, and 

specify different properties for each - a list is displayed at the top of the dialog, 

allowing you to choose a more specific context.  

For each selected context (table, row, column, etc.), you can set the border and fill 

properties, text properties (for text cells in that context) and picture properties (for 

picture cells within that context). 
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Edit Table Style _ Border and Fill Tab 

 

Edit Table Style _Text Tab 
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Edit Table Style _Picture Tab 

 

Edit Table Style _ Row pane 

 

Table Tab _ Measurements palette 
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Cell Tab _ Measurements palette 

 

Create Table from External Source _ Table Menu 

You can import tables from external sources, such as a Microsoft Excel spreadsheet, 

and apply a table style to that imported table. 

 

Table Link 

When importing a table from an external source, you can browse to the location of 

the source document, select the worksheet containing the table you wish to import, 

and select the range of cells to import.  

You can select to include the text and table formatting already included in the 

source document (“options->include formats”), and the column widths / row 

heights (“options -> include geometry”): you can also choose whether to hide or 

show any rows or columns that are hidden in the source Worksheet. 
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You can specify how many rows of the table should be considered header rows 

(“Header Rows”), whether the box will expand to fit the table (default) or whether 

the table will be resized to fit the box (“Fit to Box”), and which table style to apply. 

You can choose to import a Table along with its style from MS Excel. Simply select 

the Excel Table from the “Range” field, and let the “Table Style” drop down to be 

“Inherit “ and import. 

 

Table Break Properties 

 

Table Properties dialog 

Easy access to table formatting features directly from the 
measurements palette 

Measurements palette to offer local formatting on Home tab •
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Contextual to selection — cell, rows, columns or combination for •

formatting a selection 

Set border and fill for selected cells •

Dedicated control in the measurements palette to set Grid / Frame properties. •

Dedicated Table and Cell Tabs in the measurements palette, even when you are 

working on the cell’s content. New User interface/experience for Table Styles. 

New Features 

Simplified Table Properties (Table Creation) dialog with new options to add Table •

Header/Footer 

Support for cell level grid formatting •

Consolidation of Inline and Design (legacy) tables •

Access to a wider range of table properties through the measurements palette  •

Support for Table Header and Footer (previously, selecting header rows was •

supported only when the table breaks across the pages). Now header and footer 

rows can be defined for stand-alone tables as well, without applying Table Break 

properties. 

Table Styles to support - •

Easy to use, flexible and comprehensive formatting rules •

An intuitive user interface to set table and column/row/cell level bordering •

Set the percentage of column width that an anchored table will occupy •

Line drawing order for table borders •

The new set of formatting rules when compared with legacy table styles •

Rules specific to Column, Row and Cell level formatting •

Table Style Presets •

Presets for table border and shading styles •

Duplicate presets to create your own table styles •

Support for Text and Picture formatting in cells •

Support for Multiple Insets for text in addition to Paragraph Styles •

Picture formatting to support new fitting rules in addition to other picture •

content transforms, scaling, etc. 

Import Excel tables using new Tables Styles (not supported before for legacy •

table model) 

Box Position Reference Point 

A big benefit that QuarkXPress has always had is the ability to specify the 

positioning of objects precisely by entering coordinates in the measurements palette 

- allowing objects to be precisely aligned at specific locations. A feature commonly 
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requested by designers is the ability to define the position of page elements using 

different reference points, e.g. change the reference point to the lower right corner 

instead of using top left corner as default, when you do this, the coordinates 

displayed in the measurements palette will adjust to be relative to this point. 

When you resize a box using width and height settings on the measurements 

palette, it always grows to the right and bottom of the page. The new Box Reference 

Point option in the measurements palette will allow you to change reference point 

for all the nine points referred which include a center point: when you then resize 

the box, it will resize relative to the selected point. 

 

Box Reference Points in the measurements palette 

  

 

Box Reference point during box rotation 

  

How it works 

On the measurements palette, you can select any of 9-reference points as •

indicated 
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Once you set a Box Reference Point, all boxes in that particular layout will work •

with respect to the selected reference point. On creating a new project, the 

reference point will be reset to the ‘Top Left’. 

Previously, when you rotated any object either manually or by using a mouse, •

the object rotated from the center. In QuarkXPress 2019, the box will rotate 

from the selected Box Reference Point. 

Auto Grow/Shrink Text Boxes 

QuarkXPress 2019 introduces a new text box property to let the box grow or shrink 

automatically during text input, text import/ text copy paste/ drag and drop text. 

This feature adds huge benefit for the designer since they now do not have to keep 

dealing with the text over matter or keep readjusting box to fit to the text length. 

User can set text box width, height or both to auto. A text box can auto-grow up to 

the page margin (width wise and height wise). Auto (grow/shrink) property is only 

applicable for rectangular text boxes and will be turned off in case of non-

rectangular boxes, boxes having text angle or text skew. 

 

  

 

Auto grow values defined in measurements palette 

  

How it works 

You can now set Width/Height of box to Auto or Fixed through measurements •

palette. 

Spring Loading on Cursor 

QuarkXPress 2019 introduces support for “spring loading” of images and text on 

the cursor. This allows you to select multiple files (picture or text) at one time, and 

then place them into the layout one after the other - either into existing boxes, or 

creating new boxes dynamically - without needing to return to the Import dialog. 
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Spring Loading Images 

  

 

Spring Loading Text Files 

  

How it works 

In the import dialog, you can select multiple images or text or combination of •

images and text files to import. 
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The cursor will change to show you a thumbnail of the next file to place, and a •

counter showing how many more files are waiting on the cursor to place; 

allowing you to click onto the document page and place them as desired. 

You can import into an existing box by clicking on it, or create a new box - •

which will be created according to the image size for pictures, or between the 

margins for text boxes - by clicking onto an empty area of the page. 

You can drag and drop files onto document canvas to spring load the files onto •

the cursor. 

You can replace the image/text by pressing the Command+Shift or Ctrl+Shift •

and click on the box. 

You can cycle through the images/text by using the arrow keys in the keyboard. •

The user may append to existing text box content by using Cmd+Shift or •

Ctrl+Shift key and click in between the story, the story will flow from the clicked 

location. 

User may add additional items to spring-loaded cursor by selecting additional •

files in the import dialog. 

You can have different spring-loaded cursor for different layout or project. •

When you drag and drop a text file to a QuarkXPress layout, a new text box will •

be created automatically and it will always fit within the page margins. 

When the user drops into a box irrespective of whether it has any existing •

content or not, it will create a new box above existing box and image/text will 

be placed in it. It will not replace the existing content. 

When the user drops the image into other box types (none/text), it will create a •

new box and place the text/image in the newly created box. 

User can remove spring-loaded items from the cursor by the Escape key. •

You can undo and redo the placement of images and text dropped through •

spring loading cursor. 

The thumbnail preview is only available for images in this version of 
QuarkXPress. 

In case you want to use the legacy Drag and Drop behavior, you need to press 
the Shift key while dragging the image/ text file.
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Graphics 

Tagged PDF (PDF/UA) 

In recent days, the digital publishing practices emphasize the importance of 

Accessibility support. There has been demand from the corporate and government 

organizations, in response to legislation such as the Americans with Disabilities Act, 

and section 508 of the Rehabilitation Act of 1973. As a result, industry standards, 

such as WCAG  have been introduced, to allow the accessibility of information in 

published forms (both PDF, and websites containing HTML output), to be certified, 

ensuring that the published information is equally accessible to consumers with 

disabilities that every PDF published must be accessible. QuarkXPress introduced 

tagged PDF already in previous releases, and now it enhances the capabilities to 

produce PDF/UA standard. QuarkXPress 2019 offers export to PDF with compliance 

for PDF/UA (ISO 14289) and WCAG 2.0 standard. 

 

PDF/UA 
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How it works 

You can now select the PDF output option to conform to the PDF/UA standard •

as shown above. 

PDF/A Export enhancement 

PDF archive standards were equally desired by many governments and corporate 

organizations. We introduced PDF/A-2b and PDF/A-2u in earlier versions and now 

we enhance PDF/A support to include PDF/A-3a and PDF/A-2a standards. 

 

PDF Style 
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PDF Verification 

  

  

 How it works 

You can now choose between any of the PDF/A validations that are supported by •

QuarkXPress. 

Export as Image enhancements 

In QuarkXPress 2019, the Export as Image feature has been enhanced to now 

support exporting in a higher resolution (previous versions only allowed export at 

72ppi), and exporting to different file formats. 

QuarkXPress 2019 now also allows defining presets for exporting as image; and 

pushes image export to a new limit: High-quality, color-managed image export for 

print and digital use, allows marketeers and web designers to create stunning images 

in JPEG, TIFF and PNG and PDF (Raster) formats that resemble the quality of 

QuarkXPress layouts. 
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How it works 

Export as an image now includes PDF raster in addition to JPEG, TIFF and PNG •

formats 

To export an image, select File->Export as image, and select the file format which •

you wish to export to (JPEG, PDF, TIFF...) 

When you select the export option, you will be presented with a new dialog •

with additional export options. 

The new export options include embedding color profile (which is defined in the •

source setup for RGB) 

You can now save Image Export Styles as an additional type of “Output Style”, •

allowing you to define a reusable set of image export parameters 

You can assign a bleed value for the image export (symmetric and asymmetric) •

You can open the exported image once the export is completed in the default •

application defined at the OS level. 

Export Settings will be retained on the layout after save and reopen. •

Transparent background export option is available for PNG and PDF.•
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Text and Typography 

Paragraph alignment enhancement 

For facing pages documents, there was no easy way to set the text alignments to 

follow the spine- requiring that different paragraph styles were defined for recto and 

verso pages and many users requested for an option in paragraph style to let text 

align towards the spine or away from the spine. QuarkXPress 2019 introduces these 

options as part of paragraph alignment enhancement. 

How it works 

You will find the following new text alignment settings in the paragraph style sheet 

and measurements palette: 

Towards Spine •

Away From Spine •

Text alignment changes in case of Towards Spine and Away from Spine are visible in 

case of a facing page layout. 

 

Towards Spine alignment 
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Away From Spine alignment 

  

 

New alignment options in Paragraph Style Sheet 
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In the case of Facing Pages, there is a spine: 

Towards Spine alignment: Irrespective of the number of pages in the spread, the •

text on all the Left side pages will align to the right side (i.e. towards the spine); 

the text on all the Right side pages will align to the left side (i.e. towards the 

spine). 

Away from Spine alignment: Irrespective of the number of pages in the spread, •

the text on all the Left side pages will align to the left side (i.e. away from the 

spine); the text on all the Right side pages will align to the right side (i.e. away 

from the spine). 

In case of Non- Facing Pages, there is no spine: 

Towards Spine alignment: Irrespective of the number of pages in the spread, the •

text will align to the left side. 

Away from Spine alignment: Irrespective of the number of pages in the spread, •

the text will align to the right side. 

Paragraph formatting enhancement 

Many users had been requesting for an option to define the Space between 

consecutive paragraphs having the same paragraph style sheet applied. Prior to 

QuarkXPress 2019, whenever user defined the Space Before and Space After in a 

paragraph style sheet and the same style sheet was applied on consecutive 

paragraphs, then both the spacing would get applied on the consecutive 

paragraphs. In such cases, if the user wanted to ignore the spacing between 

consecutive paragraphs, he had to locally select the paragraphs and edit the spacing 

values. 

QuarkXPress 2019 includes a new Space Between option to help define the Space 

between consecutive paragraphs having the same paragraph style sheet applied; 

using this option you can ignore the spacing or define a custom spacing value for 

such paragraphs. This feature particularly applicable when creating Table of 

Contents and bulleted/ numbered lists. 
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Space Between set to ‘Ignore’ 

  

 

Space Between set to ‘0’ 

  

How it works 

You can now ignore or apply different spacing between consecutive paragraphs •

having the same style applied. You may want to apply this when you have 

applied space before or space after or both on multiple paragraphs and want to 

ignore or customize the spacing between consecutive paragraphs. 
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To apply Space Before/ Space After on consecutive paragraphs having the •

same style sheet: Select ‘Ignore’ value in Space Between 

To ignore the spacing between consecutive paragraphs having the same •

style sheet: Set value to 0 in Space Between 

To reduce the spacing between consecutive paragraphs having the same •

style sheet: Define any custom value in Space Between 

Space Between attribute can be imported from Microsoft Word files, RTF files, 
XPress Tags files and can also be exported from QuarkXPress to any of these 

formats.
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Digital Publishing 

Flex Layouts 

Modern Digital Publishing is embracing responsive HTML5 for web and mobile 

publishing. It also demands to support or comply with progressive web app (PWA) 

standards so that users are benefited native app like experience on the web. Over 

the past years, QuarkXPress delivered digital publishing capabilities from eBooks to 

HTML5 Publications and then iOS/Android app export straight from QuarkXPress. 

Now, QuarkXPress 2019 introduces new tooling to responsive HTML5 output, with 

the compliance for PWA standards. 

QuarkXPress 2019 adds new layout space called Flex Layouts with additional 

tooling to design response designs in a WYSIWYG environment without any HTML 

or CSS coding skills. The Flex designs can be previewed at run time for different 

device screen sizes without leaving the application, or exporting to HTML output to 

view in the browser. The HTML output from such layouts is truly responsive to any 

device aspect ratios including desktop screen ratios. 

The new tooling introduced for Flex Layouts is still familiar for existing print 

designers, without a steep learning curve. Furthermore, if you are familiar with web 

designing and CSS Flex properties, you do not need to learn a new vocabulary, as 

QuarkXPress 2019 uses CSS Flex properties and terminology, for creating responsive 

layouts, ensuring that graphic designers and web developers working on the same 

project can communicate using the same terms when discussing Flex layouts. 

You can now build responsive HTML designs from simple banner ads to micro 

websites and responsive HTML5 publications for your customers. 
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Flex Layout 

  

 

Flex Layout — In-app preview for a small device 
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Grid Settings — New Project Dialog for Flex Layout 

  

Features 

New Flex Layout space 

New project dialog for Flex layouts •

Support Grid size, instead of fixed pages or devices •

Support for Root Container •

Master Page support — master page link breaks only when content is changed; •

allows you to create consistent responsive HTML5 pages, based on a common 

layout template, just as you would for a print document - ensuring consistency 

across pages. 

Document Window 

Responsive canvas •

Column Grid view •

Layout elements snap to columns/grids •
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WYSIWYG view — Responsive behavior to help the designer to “view as you •

design” 

New Container Box 

Automatic grouping of contained elements •

Rule-based layouting for child elements •

Containers that support background color, background image, background •

video, etc. 

A new palette for “Layout Blocks” 

Pre-build configurations/structures for Layout, Sections, components and Basic •

text/picture blocks. 

Special wrapped Picture and Text boxes with desired padding/margins suitable •

for responsive behavior on the web 

New dialog to control different aspects of these layout blocks, such as: default •

padding for text and picture boxes, row sizes, container sizes, responsive break 

point for different components, etc. 

Layout blocks not only provide the ability to create web publication but also •

provide the building blocks for creating a consistent document structure. 

No bindings with layout blocks — Though you don’t have to define all the •

properties for any of the components, you still have control to change or play 

with any of the defined properties of the component to suit your needs. 

Path control allows the user to inspect the selected box’s parent hierarchy •

Hovering over any box token within this parent hierarchy will highlight the •

actual box on canvas, there by identifying each box individually 

It also provides appropriate hints of the responsibilities for each ancestral •

box 

Tool 

Introduces new tool for creating Flex Container  •

Enhanced Measurements palette 

New Tabs •

Container — Flex Container •

CSS Properties supported - display, flex-direction, flex-wrap, flow-flow, •

justify-content, align-items, align-content 

Flex — Flex items •

CSS Properties — flex-grow, flex-shrink, flex, align-self •

Box dimensions can be specified in flexible units like % •

Auto grow/shrink can include constraints like min/max height and width •

Integration 
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Ability to define in Item Styles •

Ability to save Flex layout items to a library •

Ability to use Item Picker Tool with Flex layout items •

  

Enhanced Text/Image Boxes 

Auto grow/shrink text boxes •

With the ability to apply constraints like min-max height and width •

Text/Image content effects 

Auto resize picture content (keeping crop area intact) •

Picture Fitting Modes for picture box and container background — Cover (Fill), •

Contain (Fit), Stretch, Scale 

Output 

Formats supported: •

Responsive HTML page •

Responsive HTML Publications •

Support for Parallax Effect — background container •

Vector shapes created in QuarkXPress are exported as SVGs •

Native HTML export of drop shadow, blends, blend modes, gradients, •

typography 

Can include micro-designs with Fixed HTML designs (Grouped elements) •

New Output Styles for Responsive HTML5 •

Responsive HTML5 preview in browser •

  

Benefits Summary 

Comparing Digital Fixed layouts and Flex layouts 

Fixed layouts are target device size dependent, whereas Flex can be developed •

deployed onto any device 

Fixed publication needs multiple layout designs for each target device, whereas a •

single Flex layout suffices the requirement for any device 

Flex layouts support multi-level containment hierarchy •

Effects like drop shadow, image effects, blends, etc are backed into images for •

Fixed layouts, but for Flex, they are exported natively as HTML5 equivalents 

Workspace 

Responsive HTML5 — User can now create responsive HTML5 publications •

without writing any code 
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Responsive Layouts — ability to see and test responsiveness within the layout •

Design Flex layouts using Grids •

Define your own custom grid by specifying columns, gutters, and grid size •

Design pages with easy to use responsive layout blocks •

Support for drop shadow –– drop shadows are not backed into images, rather are •

exported natively 

Support for Advanced typographic features like leading, kerning, tracking, •

paragraph shading, text shading 

Support for OpenType features •

Ability to create new vector shapes in QuarkXPress, and use them in responsive •

layouts 

Apply gradient and export them natively in HTML5 •

Image Effects –– color correct images within QuarkXPress without needing any •

other software 

Apply HTML5 native Color Blend Modes •

Support for various image fitting options like cover, container stretch, etc. •

Apply Parallax Effect on background images •

Videos can now be used as backgrounds •

Support for interactive layout elements •

Responsive layouts can be exported to create HTML5 Publications, iOS or •

Android apps 

Integration of Flex properties with Item Styles •

Fixed Layouts 

Previously, you had to convert text box as Graphics to apply drop shadow while 

working with Digital Fixed layouts. This limitation has been resolved in 

QuarkXPress 2019. Now you can apply drop shadow on text boxes without 

converting text boxes to Graphics.
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User Interface 

New Illustration Tools 

The options to merge and split two or more shapes in QuarkXPress were available 

only through Item menu. QuarkXPress 2019 adds new tools on measurements 

palette, whose icons graphically depict the merge or split behavior, making them 

more intuitive for designers to easily access and create complex shapes with the 

combination of two or more shapes. 

 

New Illustration icons in measurements palette 

  

How it works 

 Intersection: Keeps only the overlapping areas of the selected items. The •
color of the back most item is applied to the new single item. 

 Union: Combines all the selected item into one box, keeping both the •

overlapping and non-overlapping areas. The color of the back most item is 

applied to the new single item. 

 Difference: Strips the front most item from the selected items and leaves •

only the overlapping areas. 

 Reverse Difference: Strips the back most item from the selected items and •

leaves only the overlapping areas. 

 Exclusive Or: Leaves all the shapes intact but cuts out overlapping areas. It •

creates two bezier points at each location where any two lines originally 

intersected. It is used to create a ‘see-through’ effect with overlapping items. 



USER INTERFACE

What’s New in QuarkXPress 2019 | 31

 Split All Paths: Separates the items from each other until every box within •

a complex box has been split. If you use this command on a shape that has a 

hole in it, the hole becomes solid. 

 Join End Points: Two end points (one on each path) need to be placed on •

the top (or within 6 points) of each other. Merges the two points into one corner 

point. 

  

Enhanced Icons and Cursors 

QuarkXPress 2019 enhances many existing icons, cursor, and tools to improve the 

usability on hi-dpi/retina screen displays.
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Miscellaneous 

Performance Improvements 

In addition to improved image cache handling with multi-threading support, 

QuarkXPress on Windows now uses hardware acceleration to give a boost to 

graphics performance. While this improves overall image handling faster it also 

makes layout operations like scrolling, panning, Image Editing, and many other 

operations faster for image heavy documents.
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Legal notices 

©2019 Quark Software Inc. and its licensors. All rights reserved. 

Quark, the Quark logo, QuarkXPress, and QuarkCopyDesk are trademarks or 

registered trademarks of Quark Software Inc. and its affiliates in the U.S. and/or 

other countries. All other marks are the property of their respective owners.
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